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Module 4: Scheduling with Calendar
Objectives:
At the completion of this lesson you will be able to: 
· Navigating in Calendar
· Making and Moving Appointments
· Managing Appointments
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Navigating in Calendar
In the Calendar, you can schedule appointments and meetings, and review your tasks. An appointment is a scheduled activity that does not involve anyone else, whereas a meeting has invited attendees. A task is an activity you must perform and track to completion.
To manage your time effectively, you must be able to move easily from one date to another within your Outlook Calendar and to display each date in the desired view. The Calendar Ribbon offers quick access to various Calendar views.
The To Do Bar displays the Date Navigator, which looks like a monthly calendar, helps you speedily move from one week or month to another. You can even show two time zones, which helps you when traveling or when working with someone at an office in another time zone.
Below the Date Navigator, the To Do Bar shows upcoming appointments and below that the TaskPad displays a list of your Tasks. Any email that you flag will also be displayed here. Please note that the To Do Bar is not shown in the Calendar window by default, but can be enabled by accessing the View tab on the Ribbon and then using the TO Do Bar button.
Figure 1below shows the Calendar screen elements.


Date Navigator
Calendar
My Calendars
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[bookmark: _Ref345591198][bookmark: _Ref345591191]Figure 1: The Calendar Screen ElementsTaskpad


[bookmark: _Toc534344776][bookmark: _Toc534348074][bookmark: _Toc290647499]
Viewing a Day, a Week, or a Month
In the Calendar, you can display your events using the Day, Work Week, Week, Month or Schedule View arrangement. You can also choose to change the view. 
The arrangement is different from the view in that they are set through different buttons on the Ribbon and that the view includes filtering settings. 
The arrangement can be set using the buttons on the Arrange group on the Home or View tabs of the Ribbon, as shown in Figure 2  and in Figure 3 below.

[image: ]
[bookmark: _Ref346280545]Figure 2: Arrange group on the Home tab of the Ribbon
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[bookmark: _Ref345659184]Figure 3: Arrangement group on the View tab of the Ribbon

The view is set using the buttons in the Current View group of the View tab on the Ribbon, as seen in Figure 4
[image: ]
[bookmark: _Ref345660600]Figure 4: The Current View group on the View tab of the Ribbon


Table 4‑1 summarizes the default view options.

	Name
	Function

	Calendar
	The default view. In this view you can arrange your view between Day, Work Week, Week, Month (with High/Medium/Low detail) and Schedule views. 

	Active 
	Lists all active appointments, does not show past events. You can sort appointments by Subject, Start Date, End Date, and so forth.

	List
	Lists all active holidays and events.

	Preview
	Preview view is the same as the Calendar view; however it also displays the first line of information of each appointment



[bookmark: _Ref380397376]Table 4‑1: The Calendar Current View Filters

Table 4‑2 lists other popular buttons  on the Calendar Ribbon .
	Button
	Name
	Function

	[image: ]
	New Appointment
	Opens the New Appointment window so that you can create an appointment.

	[image: ]
	Print
	Allows you to print your Calendar

	[image: Delete copy]
	Delete
	Deletes an appointment from your calendar

	[image: Categorise copy]
	Categorize
	Allows you to setup colour categories for your different appointments
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	Group Schedules
	Displays the group schedules associated with this calendar

	[image: ]
	Today Button
	Takes you to the current date

	[image: ]
	Search Address Book
	Allows you to search for a particular contact in your address book



[bookmark: _Ref380373279]Table 4‑2: The Calendar Ribbon Buttons



To view a day, a week, or a month:

1. On the Ribbon, click the button for the view you want. 




In the following exercise, you will view a day, a week, and a month.

		1.
	Open the Calendar folder
	The Calendar for today, the Date Navigator, and the TaskPad appear in Day/Week/Month view.

		2.
	On the Ribbon, click the 
Week button
	The Calendar changes to Week view.

		3.
	On the Ribbon, click the 
Month button
	The Calendar changes to Month view. The TaskPad are hidden.

		4.
	On the scroll bar, click the top scroll arrow once
	The Month view starts and ends one week earlier. 

		5.
	On the scroll bar, drag the scroll box up about ¼ inch slowly
	As you drag, a box that gives you the starting date for the five-week period that would appear when you release the pointer appears, with the date changing as you continue to drag.

		6.
	On the Ribbon, click the Go to
Today button
	The Calendar continues to appear in its current view, but it changes the time period displayed to include the current day.

		7.
	On the Ribbon, click the 
Day button
	The Calendar changes to Day view, showing today’s date. The TaskPad reappear.





[bookmark: _Toc534344777][bookmark: _Toc534348075][bookmark: _Toc290647500]
Using the Date Navigator
The Date Navigator, shown in Figure 5 below, is located at the top of the To Do Bar, as discussed earlier in this module. It is not only a monthly calendar but gives you quick access to any date you want. You might have one or two months displayed in your Date Navigator, depending on your screen resolution. .
When the Calendar opens, the Date Navigator highlights the current date (December 30, 2001 in this example), so that you can find it easily. Dates on which you have scheduled appointments are shown in bold.


[image: DateViewer copy]Forward one Month
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[bookmark: _Ref345660839]Figure 5: The Date Navigator
[bookmark: _Ref374760331][bookmark: _Ref378046936]By adjusting the pane size, you can expand the Date Navigator to display more months. You adjust the pane size by positioning the mouse pointer over the left edge of the To Do Bar. When the pointer changes to the double-headed arrow shown in Figure 6 below, you can click and drag to resize the To Do Bar.
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[bookmark: _Ref345661176]Figure 6: The Double-Headed Arrow Mouse Pointer




To view appointments for a day during the current month:

1.	On the Date Navigator, click the desired date.

To adjust pane size to show a different number of months in the Date Navigator:

1.	Position the mouse pointer over the border between the panes you want to adjust.
2.	When the mouse pointer becomes the double-headed arrow mouse pointer, drag the border to the desired position.

To view appointments in another month:

1.	Click the One Month Back arrow once for each previous month or the One Month Forward arrow once for each future month.
or
1.	Click and hold the month label, and then,	on the pop-up month list, drag the mouse pointer to the desired month.
2.	Click the desired date.

.



In the following exercise, you will use the Date Navigator to view dates in your Calendar.

		1.
	On the Date Navigator, click tomorrow’s date 
	The Day Calendar for tomorrow appears.

		2.
	On the Date Navigator, click  the One Month Forward arrow
	Next month’s Date Navigator appears. The Day Calendar for the date you selected appears.

		3.
	On the Date Navigator, click the 25th of the displayed month
	The Day Calendar for the 25th of the displayed month appears.

		4.
	On the Date Navigator, click the One Month Forward arrow two times
	The Date Navigator for three months from now appears. The Calendar for the 25th of the month three months from today appears.

		5.
	Click and hold the month label
	The pop-up month list appears.

		6.
	Drag the mouse pointer to the current month
	This month’s Date Navigator appears. The Calendar for the 25th of this month appears.

		7.
	On the Ribbon, click the Go to Today button
	The Day Calendar for today appears.

		8.
	Position the mouse pointer over the border that separates the Calendar from the Date Navigator
	The mouse pointer becomes the double-headed arrow mouse pointer.

		9.
	Drag the border to the left. Once you can see two months side by side, release the mouse button.
	A calendar for an additional month appears in the Date Navigator.

		10.
	On the Date Navigator, click any date next month
	The Calendar for the date you selected appears.

		11.
	Drag the vertical border back to the right
	One column of calendars disappears in the Date Navigator.
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Viewing a Range of Dates, Several Weeks, and Discontiguous Days
You can also use the Date Navigator to view selected days, such as a five-day work week, the next three Tuesdays, three weeks, or whatever days you like. If the days are contiguous, you can drag across them to display them. If they are discontinuous, you select the days by holding CTRL and clicking the desired dates, just as you would select multiple files in Microsoft Explorer.


To view a range of dates:

1.	On the Date Navigator, drag across the dates.

To view several weeks:

1.	Position the mouse pointer near the left edge of the Date Navigator.
2.	When the pointer changes from pointing left to pointing right, drag the pointer along the left edge of the Date Navigator for the desired weeks.

To view discontinuous days:

1.	Press and hold CTRL
2.	On the Date Navigator, click each date you want to view.
3.	Release CTRL





In the following exercise, you will view a range of dates, three weeks, and discontinuous days.

		1.
	On the Date Navigator, click and drag to select Monday through Thursday of the current week
	Today, tomorrow, and the next day appear on your Calendar.

		2.
	Position the mouse pointer near the left edge of the Date Navigator
	The pointer changes to an arrow pointing right.

		3.
	On the Date Navigator, click today’s date
	Today’s date is selected and appears on your Calendar.

		4.
	Press and hold CTRL
	

		5.
	On the Date Navigator, click the date one week from today
	Today’s date and the date one week from today appear on your Calendar.

		6.
	Release CTRL
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Showing Two Time Zones
When you work regularly with an office in another time zone, you might find it helpful to display that office’s time zone as well as your own when displaying the Calendar. This can help you plan phone calls for the right time of day. You set the time zone display in the Time Zone dialog box, shown in Figure 7.

[bookmark: _Ref374768865][image: ]
[bookmark: _Ref345661293]Figure 7: The Time Zone Dialog Box




To show two time zones:

1.	Go to Backstage View by clicking the File button and choose Options.
2.	In the Options dialog box, click the Calendar button, and then scroll to the Time Zone… section.
3.	In the Time Zone section, at the Current time zone area, in the Label text box, type a short name for the current time zone.
4.	Select the Show a second time zone check box.
5.	In the additional time zone area, in the Label text box, type a short name for the second time zone.
6.	In the Time drop-down list, select a time zone.
7.	If that time zone uses daylight savings, select the Automatically adjust for daylight saving time check box.
8.	Choose OK.

Note: To change your current time zone to the second time zone, in the Time Zone dialog area, choose Swap Time Zones. This, however, affects all times displayed in all your Windows-based programs, not just the time displayed in Outlook.





In the following exercise, you will show two time zones.

	1.
	From the File menu, choose Options
	The Options dialog section appears.

	2.
	In the Options dialog section, click the Calendar button, and then scroll to the Time Zone… section.
	The Calendar Options appears.

	3.
	In the Current time zone area, in the Label text box, type a short name for your time zone
	

	4.
	Select the Show a second time zone check box
	The additional time zone area is usable.

	5.
	If necessary, select the text in the Label text box, and then type a short name for the time zone directly to the east of your current time zone
	

	6.
	In the Time drop-down list, select the time zone directly to the east of your current time zone (the next earlier time in the drop-down list)
	

	7.
	Choose OK
	The Calendar displays your time zone adjacent to the Calendar and the second time zone to the left of your time zone.
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Making and Moving Appointments
Outlook gives you the flexibility you need to manage your appointments. You usually make appointments in the Day view of the Calendar, although you can also set an appointment in the Week and the Month views. You can edit and move appointments as required in all views. Working in the information viewer, you can edit an appointment by inserting and deleting text, just as you do in a Mail message.
Moving Appointments
Sometimes you must move an appointment to another day. You can easily modify the date of an appointment in the Day and Week views. To move an appointment within the same calendar week, you can drag and drop it within Day and Week views. To move an appointment farther away in time, you can drag it to the Date Navigator.
Making Appointments
The most basic method of making an appointment is simple - click a time slot or drag a time period in your Calendar to select it, and then type a description of the appointment. If the displayed time slot is not wide enough, the text wraps automatically to the next line when it gets to the right edge of the appointment area. 
When you finish describing an appointment, Outlook saves the entry as soon as you click somewhere outside the appointment time slot. Even if you choose to exit the program, you do not need to click a Save button or choose Save from a menu to save your appointment.
You can make a more detailed appointment using the New Appointment window, shown in Figure 8 overleaf. In this window, you can enter additional comments about the appointment, such as the materials you should bring with you to the appointment, directions to the location, and so forth.
By default, Outlook displays a reminder about your appointment 15 minutes before the appointment start time. If you want to cancel the reminder or change the interval, you can do so in the New Appointment window. A bell icon appears in the time slot to indicate that you set a reminder for the appointment. 
[image: ]
[bookmark: _Ref345663792]Figure 8: The New Appointment Window



To select a time slot or time period:

1.	In the Calendar (Day, Week, or Month view), display the desired date.
2.	Click the time slot.
or
2.	Drag through as many time slots as necessary.

To create a basic appointment:

1.	Select a time slot or time period.
2.	Type a description.


To create a detailed appointment:

1.	If desired, select a time slot or time period.
2.	Double-click the selected time slot or time period.
or
2.	On the Ribbon, click the New Appointment button.
3.	In the New Appointment window, on the Appointment page, in the Subject text box, type the subject.
4.	In the Location combo box, type the location or select it from the drop-down list.
5.	If necessary, modify the Start time and End time displayed.
6.	If desired, in the large text box at the bottom of the page, type comments about the appointment.	
7.	On the Ribbon, click the Save and Close button.






In the following exercise, you will create appointments.

		2.
	Position the mouse pointer over the 2:00 P.M. time slot
	

		3.
	Drag through the 3:00 P.M. time slot
	A 1½-hour time period is selected. The previous appointment is saved.

		4.
	Type Design new floor plan 
	A Design new floor plan appointment appears in your selected time slot.

		5.
	On the Ribbon, click the New Appointment button
	The New Appointment window appears. The previous appointment is saved.

		6.
	On the Appointment page, in the Subject text box, type Reconcile accounts
	

		7.
	In the Location combo box, type office
	

		8.
	In the left Start time combo box, select the date and then type first Monday of next month
	The entry in the left Start time field is converted the actual date.

		9.
	In the right Start time combo box, select the time and type nine a.m.
	The entry in the left Start time field is converted the actual time.

		10.
	In the right End time combo box, select the time and type noon
	The entry in the left Start time field is converted the actual time.

		11.
	In the Options group on the Ribbon, take note of the reminder time 
	The default reminder time is 15 minutes.

		13.
	In the details text box, type arrange cover.
	

		14.
	On the Ribbon, click the Save and Close button
	The Calendar for today reappears.

		15.
	Display the Calendar for the first Monday of next month
	The Calendar displays the new appointment on the first Monday of next month.
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Selecting an Appointment and Modifying the Date in Day View
When you modify appointment details, you need to select the appointment before you can edit it. Figure 9 below shows the Calendar with an appointment selected. Note the prominent border displayed around the selected event. Selecting is important when changing event details using click and drag.
[bookmark: _Ref378047020][image: ]
[bookmark: _Ref345664404]Figure 9: The Calendar with an Appointment Selected
When you must move an appointment to a different day, while in in Day view, the simplest way is to use the Date Navigator. Simply drag and drop the appointment from the information viewer on to the desired date in the Date Navigator. If you want to reschedule the appointment for the following month, use the Date Navigator buttons to display the appropriate month before attempting the drag and drop operation. 


To select an appointment:
1.	Click the appointment.

To change the date of an appointment in Day view:

1.	Position the mouse pointer over the appointment.
2.	Drag the appointment to the desired date on the Date Navigator.
or
3. Use keyboard shortcut Ctrl + X to cut the appointment
4. Choose desired date on the Date Navigator
5. Use keyboard shortcut Ctrl + V to paste the appointment



In the following exercise, you will move the date of an appointment from one week to another and from one month to another in Day view.


		1.
	Display today’s appointments in Day view
	

		2.
	Adjust the Date Navigator to show two months
	The Date Navigator shows two months

		3.
	Position the mouse pointer over the Design new floor plan appointment
	.

		4.
	Drag the appointment to Friday of next week on the Date Navigator
	The appointment now takes place on Friday of next week and Friday of next week appears in the Calendar.

		5.
	Position the mouse pointer 
	

		6.
	Drag the appointment to the first Wednesday of next month on the Date Navigator
	The appointment now takes place on the first Wednesday of next month and the first Wednesday of next month appears in the Calendar.

		7.
	Position the mouse pointer 
	

		8.
	Click the appointment
	

		9.
	Ctrl + X keyboard shortcut, - Cut
	The appointment is placed on the Clipboard.

		10.
	On the Ribbon, click the Go to Today button
	Today’s date appears in the Calendar.

		11.
	Ctrl + V keyboard shortcut - Paste
	The appointment is scheduled for today at its original time.

		12.
	Adjust the Date Navigator to show just one month 
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Modifying the Event Date in Week View
You can also move an appointment in Week view. You can drag it to a new date displayed on the calendar or on the Date Navigator. Figure 10 shows the Calendar in Week view.

[image: ]
[bookmark: _Ref345664819]Figure 10: The Calendar in Week View


To modify the date of an appointment in Week view:
 
1.	Position the mouse pointer over the time area of the appointment.
2.	When the pointer becomes a four-headed arrow, drag the appointment to the new date on the Calendar or on the Date Navigator.






In the following exercise, you will modify the date of your appointment in Week view.


		1.
	On the Arrange group if he Home tab of the Ribbon, click the Week button
	The Week view appears.

		2.
	Position the mouse pointer over the time area of the Design new floor plan appointment
	The mouse pointer becomes a four-headed arrow.

		3.
	Drag the appointment to the next Friday on the Calendar 
	The appointment now takes place on Friday from 2:00 P.M. to 3:30 P.M.

		4.
	Position the mouse pointer over the time area of the appointment
	The mouse pointer becomes a four-headed arrow.

	 	5.
	Drag the appointment to today's date on the Calendar
	The appointment now takes place today.

	 	6.
	On the Ribbon, click the Day button
	Today’s Calendar appears in Day view.
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Outlook lets you easily modify the beginning and ending times of an appointment. If you must move an appointment to another time slot in the same day, you can drag and drop it. You can also change either the starting time of an appointment by dragging the top border with the double-headed arrow or change the ending time by dragging the bottom border.


To move an appointment to another time slot on the same day:

1.	Position the mouse pointer over the move handle.
2.	When the pointer becomes a four-headed arrow, drag the appointment to the new time slot.

To change the start up time or the ending time of an appointment:

1.	Position the mouse pointer over an appointment handle.
2.	When the pointer becomes a double-headed arrow, drag the appointment handle to the new time.




In the following exercise, you will change the time of your appointment.


		1.
	Position the mouse pointer over the Design new floor plan appointment
	

		2.
	Click and Drag the appointment one hour later
	

		3.
	Select the appointment again
	

		4.
	Position the mouse pointer over the top appointment handle
	The mouse pointer becomes a double-headed arrow.

		5.
	Drag the top handle to 1:30 P.M.
	The appointment now begins at 1:30 P.M.

		6.
	Position the mouse pointer over the bottom appointment handle
	The mouse pointer becomes a double-headed arrow.

		7.
	Drag the bottom handle to 3:00 P.M.
	The appointment now ends at 3:00 P.M.
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Managing Appointments
Outlook Calendar can store tentative events and recurring events. You can also mark events as all day events, in which case there is no start or end time assigned to the event. All day events will not conflict with existing events in your calendar, so they are useful to create a Calendar entry that does not affect your availability for meetings. Birthdays, religious holidays and festivals or conferences are good examples of events that you might want to schedule as an events without affect your availability.  In addition, should you need to cancel an appointment, Outlook lets you delete it so you can schedule another appointment in your newly freed time period.
Creating Recurring Appointments
Recurring events are those appointments and meetings in your schedule that occur on a regular basis, such as a biweekly review of orders or preparing a report every month.
When you schedule a recurring appointment, Outlook automatically places all future occurrences of the appointment in your Calendar for the period you specify. The Appointment Recurrence dialog box, illustrated in Figure 11, lets you define recurring appointments. 
[image: Recurrance copy]
[bookmark: _Ref345670358]Figure 11: The Appointment Recurrence Dialog Box


When you have scheduled a recurring appointment, your Calendar shows the Recurrence icon, a circle made from two arrows, which appears at the left of the appointment, as shown in Figure 12. The Recurrence icon may not be visible in Month view, depending on your screen size.

[image: ]
Figure 12: A Recurring Appointment Displaying the Recurrence Icon


To create a recurring appointment:

1.	Select a time slot or time period.
2.	From the Calendar menu, choose New Appointment. Click the Recurrence button on the Ribbon.
3.	In the Appointment Recurrence dialog box, in the Recurrence pattern area, in the left column, select a time period option button.
4.	In the Recurrence pattern area, in the right column, select the appropriate option button or check boxes and, if necessary, fill in the required information.
5.	In the Range of recurrence area, select the appropriate end date option button and fill in required information.
6.	Choose OK.
7.	Complete the New Appointment window, and then, on the Ribbon, click the Save and Close button.





In the following exercise, you will create a recurring appointment.

		1.
	On the Calendar, select 11:00 A.M. to 2:00 P.M. on the third Monday of next month
	

		2.
	From the Calendar menu, choose New Appointment, and then click the Recurrence button.
	The Appointment Recurrence dialog box appears over the New Appointment window.

		3.
	In the Recurrence pattern area of the Appoint Recurrence dialog box, in the left column, select the Monthly option button
	

		4.
	In the Recurrence pattern area, in the right column, select the second option button
	

		5.
	In the Range of recurrence area, make sure the No end date option button is selected
	

		6.
	Choose OK
	The New Appointment window appears.

		7.
	In the Subject text box, type Mayor’s monthly business lunch
	

		8.
	In the Location text box, type restaurant
	

		9.
	In the large text box at the bottom of the window, type The mayor always orders stuffed grape leaves.
	

		10.
	On the Ribbon, click the Save and Close button
	The appointment appears on the Calendar displaying the subject and the location. The appointment displays the Recurrence icon.
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Editing Recurring Appointments
You can edit recurring appointments by reopening the Appointment Recurrence dialog box. Before this dialog box appears, however, the Open Recurring Item message box, shown in Figure 13, appears. In this message box, you specify whether the change is for this occurrence only or for the entire series.

[image: ]
Figure 13: The Open Recurring Item Message Box


To edit a recurring appointment:

1.	Double-click the appointment.
or
1.	Select the appointment, and then, from the Ribbon, choose Open.
	then…
2.	In the Open Recurring Item message box, select the desired option button, and then choose OK.
3.	In the Recurring Appointment window, make the changes.
4.	If desired, from the Appointment menu, choose Recurrence.
5.	In the Appointment Recurrence dialog box, make the changes.
6.	Choose OK.
7.	In the Recurring Appointment window, on the Ribbon, click the Save and Close button.



In the following exercise, you will edit a recurring appointment.

		1.
	If necessary, select the Mayor’s business lunch appointment 
	

		2.
	From the Ribbon, choose Open
	A drop down menu appears.

		3.
	Select the Open series option button
	The Appointment window appears.

		4.
	In the Subject text box, select the word monthly and type biweekly
	

	5.
	Choose Recurrence
	The Appointment Recurrence dialog box appears.

		6.
	In the Recurrence pattern area, in the left column, select the Weekly option button
	

		7.
	In the Recurrence pattern area, in the right column, select the number in the Recur every…weeks text box, and then type 2
	

		8.
	Choose OK
	The Recurring Appointment window shows the appointment recurring every two weeks beginning with the selected date.

		9.
	On the Ribbon, click the Save and Close button
	The edited appointment appears on the Calendar.
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Creating Tentative Appointments
Tentative appointments are appointments for which you need to reserve a time slot even though they might not take place, or you might not be able to attend
If you have a recent version of Microsoft’s Exchange Server as your email server, your calendar will display any meeting request you receive as a tentative event in your calendar, so even if you have not read or accepted the meeting request other users will know that you have a tentative event and might not be available. As soon as you accept the request the event status changes from tentative to busy.
Tentative appointments display a striped left border, as shown in Figure 14.
[image: ]
Figure 14: A Tentative Event


To create a tentative appointment:

1.	Create an appointment but do not close the New Appointment window.
2.	From the Options Grouping on the Ribbon, select the down arrow next to busy and select Tentative.
3.	On the Ribbon, click the Save and Close button.






In the following exercise, you will create a tentative appointment.

		1.
	On the Date Navigator, select next Tuesday 
	The Calendar displays next Tuesday.

		2.
	On the Calendar, select the time period from 9:00 A.M. to 1:30 P.M.
	

		3.
	On the Ribbon, click the New Appointment button
	The New Appointment window appears.

		4.
	In the Subject text box, type Excel training class
	

		5.
	From the Show time as drop-down list, select Tentative
	

		6.
	On the Ribbon, click the Save and Close button
	The appointment appears on the Calendar. The move handle is shaded blue/white...
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All Day Events
You can remember special business and personal days by creating a calendar event and specifying it as an All Day Event, as shown in Figure 15.
[image: ]
[bookmark: _Ref345671020]Figure 15: The New Event Window
Outlook displays All Day events at the top of the day on which it occurs, as illustrated in Figure 16 below. Remember that All Day events do not affect you availability, so when other view your calendar you will still be free for meetings.
[image: ]
Figure 16: The Calendar with an All Day Event



To insert events:

1.	From Calendar, choose New Appointment.
2.	In the New Event Appointment, complete the text boxes; select the options buttons and check boxes, and so forth, as if you were creating a new appointment.
3.	Make sure the ‘All day event’ check box is selected.
4.	On the Ribbon, click the Save and Close button.




In the following exercise, you will insert an event.

		1.
	From the Calendar menu, choose New Appointment
	The New Appointment window appears.

		2.
	In the Subject text box, type Fiesta Launch Party
	

		3.
	From the Start time drop-down calendar, type February 24, 2005 or the date your instructor tells you
	

		4.
	Make sure the All day event check box is selected
	

		5.
	On the Ribbon, click the Save and Close button
	The Calendar reappears.

		6.
	Go to the date you selected for Mardi Gras
	The event appears above the Calendar on the selected date.
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Deleting Appointments
You should delete appointments as soon as you decide to cancel them. Prompt deletions keep your Calendar up-to-date and give you and your colleagues an accurate picture of your availability. You can use the Ribbon button to delete appointments.


To delete an appointment:

1.	Select the appointment.
2.	On the Ribbon, click the Delete button.





In the following exercise, you will delete an appointment.

		1.
	Display today’s date
	

		2.
	In the Calendar, select the Call to check for new deliveries appointment
	

		3.
	On the Ribbon, click the Delete button
	The appointment is deleted.
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Restoring Deleted Appointments
If you delete an appointment in error you can restore it using Undo, provided that you restore it immediately. If you take any other action before restoring the appointment the Undo method will not work.
You can also restore the deleted event from your deleted items folder. 


To restore a deleted appointment immediately after deleting it:

1. From the Quick Access Toolbar, choose Undo Delete.

To restore an event from the deleted items folder:
1. Go to the Deleted Items folder in the folder list.
2. If possible, locate the event in the folder list.
3. Drag and drop the event on to the Calendar shortcut in the Navigation Pane.




In the following exercise, you will restore a deleted appointment.

		1.
	On the QAT, click the Undo Delete button
	The Call to check for new deliveries appointment is restored.
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	1.	On the second Friday of next month, make a one-hour appointment located in your office beginning at 9:00 A.M. to review preparations for the mayor’s biweekly luncheon. Make a note that says: Order all ingredients for stuffed grape leaves. 
	2.	Move the appointment to the second Thursday, and then change the start time to 9:30 A.M.
	3.	Shorten the appointment to end at 10:00 A.M.
	4.	Display Friday of the previous week. Make a one-half hour appointment that recurs weekly at 4:30 P.M. to review your inventory.
	5.	Set the inventory appointment to occur biweekly.
	6.	On the second Tuesday of every month, create a recurring appointment from 6:00 P.M. to 9:00 P.M. to teach a culinary course at the Culinary Institute.
	7.	Set a reminder for the culinary course for two hours before the course begins.
	8.	On the fourth Friday following the current date, create a tentative appointment from 5:30 P.M. to 6:00 P.M. for a haircut at Snippets.
	9.	Delete the haircut appointment and restore it immediately.
	10.	View your appointments for this week, and then view your appointments for the entire month. Then return to Day view.
	11.	Show only your time zone.
	12.	Insert your birthday as a recurring All Day event in your calendar.
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